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Introduction to Virtual PC for Mac 

Who should read this guide? 
This document provides deployment information for IT professionals working in corporate 
environments who have purchased the volume licensing version of Microsoft Virtual PC for Mac 
Version 7. To install and configure a volume licensing version of Virtual PC for Mac, you should be 
familiar with Windows and the settings that are required to connect a Windows-based computer on 
your network. 

If you are installing any version of Virtual PC for Mac that is not a volume licensing version, refer to the 
documentation included with your software. 

About Virtual PC for Mac 
Virtual PC for Mac is designed for Macintosh users who sometimes need access to Windows-only 
programs. Virtual PC for Mac is a cost-effective alternative to purchasing a second computer for 
someone who requires access to both operating systems.  

You can use Microsoft Virtual PC for Mac to create one or more virtual machines, each running its own 
operating system, on a single Macintosh computer. The virtual machine emulates a standard 
x86-based computer, including all of the basic hardware components. By using emulated hardware, 
each virtual machine works like a separate physical computer. 

This virtual machine is much like a real computer. You install an operating system on it, such as 
Windows XP, as well as programs, such as Microsoft Access or Microsoft Visio. The virtual machine 
appears in its own window on the Mac, and users can switch easily between programs on a virtual 
machine and programs on the Mac. 

Virtual PC for Mac is as easy to use as any Macintosh program. For example, the user can do the 
following 

• Switch from Mac OS to Windows and back with a mouse click. 

• Drag files and folders from the Macintosh desktop to the Windows desktop and back again.  

• Start Windows-based programs by using the Windows Start menu in a virtual machine window 
or by adding Windows program icons to the Dock. 

• Print from the virtual machine by using the same printer drivers as the Mac OS uses — no 
additional configuration required (users of Mac OS 10.3 or later only). 
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To use Virtual PC for Mac and your virtual machine, you must interact with three separate user 
interfaces: 

• Windows 

• Virtual PC for Mac 

• Mac OS X 

 

  Windows 

  Virtual PC for Mac program 

  Mac OS X 
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How Virtual PC for Mac works 
Each virtual machine running on Virtual PC for Mac acts as a standalone computer. It has its own 
emulated sound, video, and network cards as well as its own emulated processor. And each virtual 
machine runs its own operating system. Microsoft fully supports the following operating systems 
running in a virtual machine on Virtual PC for Mac: Microsoft Windows 2000 Professional, Windows XP 
Professional, and Windows XP Home Edition. 

 

Virtual PC for Mac uses the built-in Ethernet port on the Macintosh computer to connect to the Internet 
or network servers. By default, virtual machines connect to the Internet and networks by using Shared 
Networking. Shared Networking uses Network Address Translation (NAT) to share the TCP/IP 
connection for your Macintosh computer. A virtual machine can also connect to the Internet and 
networks by using Virtual Switch networking. Virtual Switch networking requires a separate IP address 
for the virtual machine to establish its own TCP/IP connection. 

Programs that users install on their virtual machines work the same way that they do on a 
Windows-based computer, including business, education, Internet, and other programs. And most 
devices that users connect to their physical computers, such as printers, modems, CD-ROM drives, 
and so on, also work with their virtual machines. 

Note   A virtual machine running Windows is exposed to the same security risks faced by 
Windows-based computers. To lower the risk, users should always install the latest Windows security 
patches and service releases.  
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Benefits of Virtual PC for Mac 
Virtual PC for Mac is a time-saving and cost-saving solution in any scenario in which users must run 
both Macintosh and Windows operating systems. In the corporate environment, it provides your Mac 
users access to necessary Windows programs. Rather than purchasing multiple computers, one for 
each operating system, Mac users can use Windows-based software, files, and networks right from 
their Macs. This saves their organizations not only hardware costs but also overhead costs, such as 
power and additional office resources. 

Virtual PC for Mac helps extend your current investment in hardware and software. If you have 
developed custom line of business (LOB) programs exclusively for the Windows platform, such as 
expense reporting tools, finance tools, and customer databases, Virtual PC for Mac saves you the 
need of purchasing additional Windows-based machines for your Mac users or porting the Windows 
software. 

Scenarios in which people typically use multiple operating systems include technical support, quality 
assurance, Web site design, training, and collaboration. In the case of technical support, Virtual PC for 
Mac helps support technicians provide quicker responses and reduce call times. Rather than 
maintaining multiple computers or restarting computers for different support calls, they can simply 
start a pre-built virtual machine that matches the caller’s configuration — almost instantly. With Virtual 
PC for Mac, test engineers are able to test programs against a wider variety of operating systems in 
shorter amounts of time. In addition, Virtual PC for Mac provides quicker reconfiguration times for 
computers in training rooms and enables more diverse classes based on more computer 
configurations. In an academic setting, researchers can use Virtual PC for Mac to collaborate with 
colleagues who use Windows-based software for their design, data collection, and analysis. 

Note   Virtual PC for Mac might not be an optimal platform in some cases. For example, certain types 
of specialized graphics-intensive software, such as three-dimensional (3-D) automation tools and 
games, might not run on Virtual PC for Mac or might not perform as expected. Also, we recommend a 
dedicated Windows-based computer in cases where a user is required to run Windows programs a 
majority of the time. 



 

Introduction to Virtual PC for Mac 

9 

What's new in Virtual PC for Mac Version 7 
Virtual PC for Mac Version 7 includes many improvements in performance and ease of use. 

• Improved performance   Enjoy improved graphics and visual display, and an experience 
optimized for Mac OS X. Programs launch quickly, refresh easily, and are more responsive 
than in prior versions of Virtual PC for Mac. 

• G5 support   Run Windows-based programs on the fastest new hardware from Apple. 

• Easy installation   Get started quickly with streamlined installation of Virtual PC for Mac. 

• Easy printing   Use the same printer as your Macintosh computer uses if you are running  
Mac OS X version 10.3.x (Panther) or later. 

• Fast save   Shut down and save the state of your virtual machine in one easy step. When you 
use the Fast Save feature, all Windows-based programs that are running on your virtual 
machine when you shut down will be running when you restart your virtual machine. 

• Expanded preferences and settings   Customize your virtual machine by using new application 
preferences and virtual machine settings. 

About virtual machine components 

Each virtual machine that you create has the following components: 

• Virtual machine window   The virtual machine appears in this window on the Macintosh 
desktop. The name of the virtual machine appears in the title bar and the Virtual PC for Mac 
toolbar appears at the bottom. 

• A configuration document   Each virtual machine that you create is represented in Mac OS X 
by a configuration document. A configuration document contains all of the configuration 
information for a virtual machine, including the virtual machine settings and the virtual hard 
disk image. It has the same name as the virtual machine. 

• Virtual hard disk image   A virtual hard disk image functions like a physical hard disk. The 
virtual hard disk image dynamically expands as you install programs or store data in it. 

• An operating system installed in the virtual hard disk image   An operating system must be 
installed in the virtual hard disk image. If the operating system that you want to install is not 
included with Virtual PC for Mac, you must purchase and install an operating system. 

The supported operating systems are Windows XP Professional, Windows XP Home, and 
Windows 2000. Refer to the Read Me for specific details about the supported operating 
systems. The Read Me is included on the Virtual PC for Mac installation CD, and in Virtual PC 
for Mac on the Help menu. 

• Emulated hardware   The virtual machine emulates a standard x86-based computer, including 
all of the basic hardware components. 
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Setup and configuration checklist 
The following summarizes the process of installing and configuring Virtual PC for Mac Version 7. 

Step 1 Before You Install Virtual PC for Mac 
Review the requirements for Virtual PC for Mac. 

Step 2 Install Virtual PC for Mac 
Follow the on-screen instructions of the Virtual PC for Mac Assistant. 

Step 3 Create an empty virtual machine 
Follow the on-screen instructions of the Create New PC Assistant. This creates an 
empty virtual machine on which you will install a Windows operating system. 

Step 4 Install an operating system 
Install a Windows operating system on the empty virtual machine. You can install 
Windows XP Professional, Windows XP Home Edition, or Windows 2000. 

Step 5 Install Virtual Machine Additions 
Install Virtual Machine Additions on a Windows operating system to provide 
system integration features (such as mouse integration and shared folders). 

Optional Configure a virtual machine 
Configure and set up preferences for Virtual PC for Mac and Windows to ensure 
that they work properly. 

See page 17 for information on setting up networking. 

See page 20 for information on setting up printers. 

See page 22 for information on setting up shared folders. 

Optional Install Windows-based programs 
Installing a Windows-based program is easy: Start a virtual machine, insert the 
installation CD, and follow the on-screen instructions. See page 28. 
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Installing Virtual PC for Mac 
This section provides instructions on installing the volume licensing version of Virtual PC for Mac.  

Note   If you are installing any version of Virtual PC for Mac that is not a volume licensing version, refer 
to the documentation included with your software. 

About automated installations 
Virtual PC for Mac does not support or include tools for automated installations across a network — 
you must install Virtual PC for Mac manually on each computer. After you create a virtual machine and 
install a volume licensing version of Windows on it, you can copy the virtual machine over the network 
to other Macintosh computers. See page Error! Bookmark not defined. for more information. 

Step 1: Before You Install Virtual PC for Mac 
Read the following information prior to installing Virtual PC for Mac. 

System requirements 
To install and run Virtual PC for Mac, you must have the following: 

• A native G3, G4, or G5 Macintosh computer — Microsoft does not support processor upgrade 
and/or accelerator cards for use with Virtual PC for Mac 

• Mac OS 10.2.8 or Mac OS 10.3.x 
Note   To run Virtual PC for Mac on a G5 Macintosh, you must be running Mac OS 10.3.x. 

• At least 512 MB of RAM and 3 GB of free hard-disk space 

• A 700 MHz processor, minimum 

For optimal performance in Virtual PC for Mac, Microsoft recommends using video cards that support 
Quartz Extreme, such as nVidia GeForce or ATI Radeon. 

Supported operating systems 
You can install the following operating systems on a virtual machine in Virtual PC for Mac: 

• Windows XP Professional 

• Windows XP Home Edition 

• Windows 2000 

Note   These operating systems are not included with the volume licensing version of Virtual PC 
for Mac. 
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Product keys 
The product key for the volume licensing version of Microsoft Virtual PC for Mac is preset, and you are 
not required to enter this key during installation. If you are installing any version of Microsoft Virtual PC 
for Mac which is not a volume licensing version, refer to the documentation included with your 
software for the location of the product key. 

To install your Windows operating system on a virtual machine, you need the product key for your 
operating system. The Windows product key is different than the key used by Virtual PC for Mac. 

Step 2: Install Virtual PC for Mac 

To install Virtual PC for Mac 
1. Insert the Virtual PC for Mac installation CD into the CD drive on your Macintosh computer. 

The following installation screen appears.  

 

If the installation screen does not automatically appear, double-click the Virtual PC for Mac 
Version 7 CD icon that appears on the Macintosh desktop.  
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The installation screen has three options: 

• Install Virtual PC   This opens the Virtual PC for Mac installer.  

• Read Me   This document contains important information regarding Virtual PC 
for Mac. 

• Manuals & Tools   This folder contains an electronic copy of the Getting Started 
guide and a tool for removing Virtual PC for Mac. 

2. Double-click Install Virtual PC. 

The Welcome to the Virtual PC Installer screen appears. 

3. Follow the on-screen instructions. 

When you restart your Macintosh computer (when prompted), be sure you log on as an 
administrator. After you log on as an administrator, the Virtual PC for Mac Setup Assistant 
starts. If the Virtual PC for Mac Setup Assistant does not start immediately after you log on as 
an administrator, double-click the Applications folder, and then double-click Virtual PC. 

4. Follow the on-screen instructions for the Virtual PC for Mac Setup Assistant. This Assistant 
helps you complete the Virtual PC for Mac installation. 

Step 3: Create an empty virtual machine 
After you install Virtual PC for Mac, use the following procedure to create an empty virtual machine. 

To create an empty virtual machine 
1. If the Create New PC Assistant does not start immediately after completing the Virtual PC 

for Mac installation, in Virtual PC for Mac, on the File menu, click New. 

The Create New PC Assistant opens. 

2. Click Install your own operating system, and then click Begin. 

This allows you to create an empty virtual machine where you can install your operating 
system. 

3. Click Continue. 

4. In the Operating System list, click the operating system that you want to install on your virtual 
machine. If the operating system that you want to install is not listed, click Unspecified. 

The Assistant displays possible formats for the virtual hard disk image based on the operating 
system you selected. 

Note   Only Windows XP Professional, Windows XP Home Edition, and Windows 2000 are 
supported in Virtual PC for Mac. You can install and run other Windows and non-Windows 
operating systems, but these operating systems are not supported in Virtual PC for Mac and 
may not perform as expected. 



 

Installing Virtual PC for Mac 

14 

5. Select the format you want to use for the virtual hard disk image, and then click Continue.  

The default format is the format recommended for your operating system. Some file formats 
are not compatible with certain operating systems. Incompatible formats for the selected 
operating system appear dimmed and cannot be selected. 

6. In the Name box, type the name for your virtual machine.  

You can either accept the name that is provided or create your own name. For best results, 
use the name of the operating system that you are installing (for example, Windows XP 
Professional). 

7. To install the configuration document (which contains the configuration information and 
operating system files for your virtual machine), do one of the following: 

• To accept the default installation location, click Create. 

By default, the Assistant installs configuration information and operating system files for 
your virtual machine in the User/Documents/Virtual PC List folder on your Macintosh 
hard disk. 

• To select a different installation location, click Change Location, select a location, and 
then click Create. 

8. Close the Create New PC window. 

You are now ready to install your operating system on the new virtual machine. 

Step 4: Install an operating system 
Note   These steps describe installing Windows XP. If you are installing a different operating system, 
some steps may be different than described below. Depending on the speed of the host Macintosh, 
the time it takes to install the operating system ranges from approximately 30 minutes to over 
2 hours. 

To install an operating system on an empty virtual machine 
1. In the Virtual PC List, double-click the empty virtual machine that you want to install an 

operating system on.  

A black screen with the following message appears: “OS not found. Install an OS on this 
hard drive.” 

2. With Virtual PC for Mac in the foreground, insert the CD that contains the operating system 
into the CD drive of your Macintosh computer.  

The CD is now captured for use by Virtual PC for Mac. When a CD is captured for use by 
Virtual PC for Mac, the CD image in the Virtual PC for Mac toolbar is no longer shaded. 
If the CD is not automatically captured, in Virtual PC for Mac, on the Drives menu, click 
Capture Disc. 
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If you have an operating system that requires installing from a floppy disk, you need either 
a floppy disk drive on your Macintosh computer or a floppy disk image that contains the 
installation information. If your Macintosh computer does not have a floppy disk drive, you 
can copy the contents of the physical floppy disk from another Macintosh computer to a 
network location that you can access. For more information about using floppy disk images, 
see “Create a floppy disk image” in the Virtual PC for Mac Help. 

3. In Virtual PC for Mac, on the PC menu, click Reset. 

4. To confirm that you want to restart the virtual machine, click Reset again. 

5. When the message “Press any key to boot from CD” appears, immediately press any key on 
your keyboard.  

Note   You must press a key quickly, without pausing. Otherwise, the black screen with the 
message “OS not found. Install an OS on this hard drive.” appears again, and you will need to 
repeat steps 3 and 4. 

Windows files are installed. 

6. Follow the on-screen instructions for Windows XP Setup. The following list shows some of the 
choices to make during setup: 

• Default file system    The file system that is selected by default is the partition 
option that you selected in the Create New PC Assistant. Use the default file system 
unless you are sure that you need to select a different file system. 

• NTFS   Do not convert your file system to the NTFS file system unless you are certain 
that you want to use the NTFS file system. You cannot convert back to a FAT file 
system after you have used an NTFS file system. In addition, the Virtual Disk 
Assistant in Virtual PC for Mac cannot modify or examine NTFS file systems. 

• Typical vs. custom network settings   To avoid compromising the performance of 
Virtual PC for Mac, select Typical. These network settings have been preconfigured to 
perform the majority of tasks in Windows. If you select Custom, always use DHCP 
unless you are using a domain or your network requires a setting other than DHCP. 

• Domain or workgroup   If you are unsure if the virtual machine is a member of a 
domain, use the default Workgroup setting. You can join the virtual machine to a 
domain later, after installing Windows. If you join a domain, use the fully qualified 
name of the domain, headquarters.corp.adatum.com, for example. 

Once you have finished installing an operating system, you are ready to install Virtual Machine 
Additions. 
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Step 5: Install Virtual Machine Additions 
You can install Virtual Machine Additions on Windows 2000 and Windows XP operating systems to 
provide system integration features, including:  

• Mouse integration   Move the mouse freely between Macintosh and Windows operating 
systems.  

• Shared folders   Share information between your Macintosh computer and your virtual 
machine, or among multiple virtual machines.  

• Performance enhancements   Improve the performance of Windows when you add these 
optimized video drivers. 

• Drag-and-drop operations   Copy files easily by dragging the files between the Windows and 
Macintosh operating systems.  

• Time synchronization   Synchronize the clock in the Windows operating system with the clock 
in the Macintosh operating system. 

• Dock support   Start a virtual machine from the Macintosh Dock.  

• Easy printing   Use the same printer as your Macintosh computer uses if you are running 
Mac OS X version 10.3.x (Panther) or later. No special configuration is required. 

To install Virtual Machine Additions 
1. Start a virtual machine.  

2. Make sure you are logged on to Microsoft Windows as an administrator. 

3. When the Windows desktop appears, hold down the COMMAND ( ) key, and then move the 
mouse pointer outside the virtual machine window and onto the Macintosh desktop. 

4. In Virtual PC for Mac, on the PC menu, click Install or Update Additions. 

5. Follow the on-screen instructions. 

6. Click Finish. 

7. To restart your computer now so that configuration changes take effect immediately, 
click Yes.  

You are now ready to configure your virtual machine. 
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Configuring a virtual machine 
After you have a virtual machine with a version of Windows installed on it, you need to configure both 
the Virtual PC for Mac program and Windows to ensure that they work properly. Specifically, you need 
to configure and set up: 

• Networking 

• Printing 

• Shared folders 

• Virtual PC for Mac preferences 

• Additional programs 

Note   The information in this section applies only if you installed a Windows operating system. 

Set up networking 
In Virtual PC for Mac, a virtual machine can connect to the Internet and network servers in one of the 
following two ways. 

• Shared Networking   By using Shared Networking, the virtual machine can share the Internet 
connection established for the Macintosh computer, whether the Macintosh computer is 
connected through a modem or a LAN. Shared Networking works well for standard networking 
tasks, such as browsing the Web and reading e-mail. It can also be used to access shared 
resources, such as FTP sites, printers, or files. 

A virtual machine that uses Shared Networking cannot act as an Internet server. Shared 
networking uses TCP/IP. Other network protocols, such as Novell IPX/SPX and NetBEUI, are 
not supported. If you must use one of these other protocols, use Virtual Switch networking 
instead of Shared Networking.  

Note   If you are using an Airport connection to access your network, use shared networking 
to ensure reliable network connectivity. 

• Virtual Switch   By using Virtual Switch networking, a virtual machine that is running Microsoft 
Windows can have a unique network connection that is separate from that of the Macintosh 
computer. A virtual machine that uses Virtual Switch networking can run server programs and 
act as an Internet server. Virtual Switch networking is needed to run some networking 
software, such as chat programs. Use Virtual Switch networking only if you are knowledgeable 
about network configuration. 

If you use Virtual Switch networking, you can either obtain a TCP/IP address from a DHCP 
server or use a TCP/IP address that differs from the TCP/IP address used by the Macintosh 
computer. To view the TCP/IP address used by the Macintosh computer, on the Apple menu, 
click System Preferences, and then click Network. 
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Set up Shared Networking 
To set up Shared Networking, you must specify networking settings in Virtual PC for Mac and configure 
Microsoft Windows to automatically obtain a TCP/IP address from a DHCP server. Typically, these are 
the default settings for both Virtual PC for Mac and Windows. 

By default, Shared Networking is selected as the network setting. Use the following two procedures to 
change the network setting to Shared Networking if the network setting is currently set is to Virtual 
Switch. You can use the first procedure to determine the current network setting. 

Note   With Shared Networking, Virtual PC for Mac acts as the DHCP server. No other DHCP server is 
necessary. 

To set up Shared Networking in Virtual PC for Mac 

1. Start Virtual PC for Mac, and then start the virtual machine that you want to configure. 

2. On the PC menu, click PC Settings. 

3. Click Networking. 

4. Select Enable networking, and then click Shared Networking. 

5. Click OK. 

After you set up Shared Networking in Virtual PC for Mac, you can configure Windows to work with 
Shared Networking by using the following procedure. 

To configure Windows to work with Shared Networking 

1. In Windows, click Start, and then click Control Panel. 

2. Double-click Network Connections.  

If you do not see Network Connections, in the list on the left of the Control Panel, click Switch 
to Classic View. 

3. Double-click your network connection. 

4. On the General tab, click Properties. 

5. Click Internet Protocol (TCP/IP), and then click Properties. 

6. Click Obtain an IP address automatically. 

7. Click OK. 
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Set up Virtual Switch networking 
To set up Virtual Switch networking, you must specify networking settings in Virtual PC for Mac and 
configure Microsoft Windows either to automatically obtain a TCP/IP address from a DHCP server or 
to use a static TCP/IP address. 

To enable Virtual Switch networking, you must: 

• Configure Virtual PC for Mac 

• Configure your operating system 

To configure Virtual Switch networking for a virtual machine 

1. Start Virtual PC for Mac, and then start the virtual machine that you want to configure. 

2. On the PC menu, click PC Settings. 

3. Click Networking. 

4. Select the Enable networking check box, and then click Virtual Switch. 

5. Click Restart. 

After you configure Virtual Switch networking for a virtual machine, you can configure Windows to work 
with Virtual Switch networking by using the following procedure. 

To configure Windows to work with Virtual Switch networking 

Note   You can configure networking in Windows on your virtual machine the same way you would 
configure networking for any other Windows computer. 

1. In Windows, click Start, and then click Control Panel. 

2. Double-click Network Connections.  

If you do not see Network Connections, in the list on the left of the Control Panel, click Switch 
to Classic View. 

3. Double-click your network connection. 

4. On the General tab, click Properties. 

5. Click Internet Protocol (TCP/IP), and then click Properties. 
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6. Do one of the following: 

• To obtain a TCP/IP address automatically, click Obtain an IP address automatically. 

• To use a static TCP/IP address, click Use the following IP address, and then fill in the 
information. 

Note   In addition to requiring an IP address, network and dial-up connections on a TCP/IP 
network might require a mechanism to map computer names to IP addresses. Four name 
resolution options are available: DNS (Domain Name System), WINS (Windows Internet Name 
Service), broadcast name resolution, and the Hosts and Lmhosts files. 

7. Click OK. 

Important   If your network uses a proxy server, you need to configure your Internet settings 
to use the proxy server before you can access your network. To configure your Internet 
settings to use the proxy server, in Internet Explorer, on the Tools menu, click Internet 
Options, and then on the Connections tab, click LAN Settings. 

Set up printers 
In Virtual PC for Mac, there are several ways to establish a printer connection for your virtual machine. 
The method you choose depends on the operating system that is installed on your Macintosh 
computer and whether the printer you want to use is a printer directly connected to your Macintosh 
computer or a printer on a network. 

Use the following table to determine the printer connection that is best for you. 

I am running 
Mac OS X 

My printer is Recommended printer connection for your 
virtual machine 

Connected directly to my 
Macintosh computer 

Use the Virtual Machine Additions Printer. Version 10.3.x 
or later 

On a network Use the Virtual Machine Additions Printer. 

Connected directly to my 
Macintosh computer 

Connect to the USB printer independently of the 
Macintosh computer. 

Version 
10.2.8 

On a network Configure your printers from within Windows the same 
way you would configure a printer for any other Windows 
computer. 

 
Important   In Virtual PC for Mac, the virtual machine does not automatically capture USB printers for 
use. To use a USB printer with a virtual machine, you must first capture the USB printer for use by the 
virtual machine. For more information about using USB devices with a virtual machine, see Virtual PC 
for Mac Help. 
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If you are running Mac OS X version 10.3.x on your Macintosh computer 
If your Macintosh computer is already set up to print from either a printer connected directly to it or a 
printer on a network, use the Virtual Machine Additions Printer driver as the printer connection for your 
virtual machine. The Virtual Machine Additions Printer driver uses the printer connections that have 
already been established for your Macintosh computer and requires no additional configuration. The 
Virtual Machine Additions Printer driver can be used only with a virtual machine that is running a 
supported operating system. 

The driver for the Virtual Machine Additions Printer is automatically installed with Virtual Machine 
Additions. 

To use the Virtual Machine Additions Printer driver, Virtual Machine Additions must be installed for a 
new virtual machine that contains a version of Windows XP purchased separately from Virtual PC for 
Mac. You can also use the Virtual Machine Additions Printer driver if you update Virtual Machine 
Additions after importing a virtual machine. 

Note   Before you can use the Virtual Machine Additions Printer driver, you must first set up a printer 
for your Macintosh computer and verify that it is working properly.  

Tips 

• If other printers are installed in the Windows operating system of the virtual machine, you 
must select the Virtual Machine Additions Printer as your default printer.  

• The Virtual Machine Additions Printer is the recommended and easiest printer connection, but 
you can also connect your virtual machine to a USB printer independently of the Macintosh 
computer or use emulated printing.  

If you are running Mac OS X version 10.2.8 on your Macintosh computer 
If the printer you want to use is a USB printer that is connected directly to your Macintosh computer, 
you can establish a separate USB printer connection for your virtual machine that is independent of 
the USB printer connection for your Macintosh computer. This means that the USB printer and the 
necessary printer drivers must be installed in the Windows operating system on your virtual machine 
in addition to being installed on your Macintosh computer. 

If the printer that you want to use is on a network, configure your printers from within Windows the 
same way you would configure a printer for any other Windows computer. 

It is also possible to use emulated printing as the printer connection for your virtual machine. 
However, the emulated printing connection can result in poor quality and performance. You should 
use emulated printing only if no other printing option is available.  

To learn how to select the Virtual Machine Additions Printer as the default printer in Virtual PC for Mac 
and in Windows XP and Windows 2000, see Virtual PC for Mac Help. 
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Set up shared folders 
You can easily transfer files between Mac OS X and Microsoft Windows by creating shared network 
folders that are available in both operating systems, or by simply dragging a file from one operating 
system to the other. 

Dragging and dropping files 
If your virtual machine is using Windows XP or Windows 2000, and you install Virtual Machine 
Additions, you can share files between the different operating systems by dragging and dropping files. 
This copies the file from one operating system to the other. For example, if you are working on a file on 
your Macintosh computer and you want to copy that file to your virtual machine running Windows XP, 
you can simply drag the file from your Macintosh computer onto your Windows XP desktop. 

Shared network folders 
Shared network folders allow a file to be available in both operating systems. You can use that file in 
both operating systems as long as the program that is needed to open the file is installed in both 
operating systems. For example, if you create a file in Microsoft Word for Mac, to open the file in the 
Windows operating system you need Microsoft Word for Windows installed on the virtual machine. 

Shared network folders are named differently in Mac OS X and Windows. In Mac OS X, these folders 
are identified by a name. In Windows, these folders are called network drives, and are assigned to a 
drive letter, such as drive “Z.” 

A folder in Mac OS X can also be shared by multiple virtual machines that are running simultaneously. 
Because virtual machines cannot directly share files and folders, shared network folders provide an 
easy way to share and transfer files and folders between multiple virtual machines and the Macintosh 
computer. 

To create a shared network folder 
1. Start the virtual machine. 

2. On the PC menu, click PC Settings. 

3. Click Shared Folders. 

4. Under Shared Folders Settings, click Share Folder. 

Tip   You can quickly open the Shared Folders setting by clicking the folder icon on the 
Virtual PC for Mac toolbar. 
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5. Do one of the following:  

• To share an existing folder, browse through the list of folders to find the one you want to 
share. 

• To create a new folder, click the location where you want to create a new folder. Click 
New Folder, type the folder name, and then click Create. 

6. Additionally, you can do either of the following:  

• To change the disk that this shared folder is assigned to in Microsoft Windows, click a 
letter in the Drive Letter box. 

• To make this folder is available every time you start the virtual machine, select the 
Share every time check box. If the virtual machine is currently running, you must restart 
it before this setting will work. 

7. Click Share. 

8. On the Settings page, click OK. 

To access the shared folder in Mac OS X 
• In the Mac OS X Finder, navigate to the folder that is shared with Windows. 

To access the shared folder in Windows 
1. Start the virtual machine that has the shared folder you want to access. 

2. On the Start menu, click My Computer. 

3. Double-click the network drive associated with the shared folder. 

Configure Virtual PC for Mac preferences 
After you create your virtual machine, you need to configure it. In Virtual PC for Mac, you can set both 
application preferences and virtual machine settings. 

Application preferences 
Application preferences apply to all of the virtual machines that you created in Virtual PC for Mac. They 
are set for the Virtual PC for Mac program rather than the individual virtual machine. Application 
preferences control behavior such as sound, CPU usage, visual display, and other behavior that 
applies to all virtual machines in Virtual PC for Mac. 

Note   For default behavior, you do not need to change these settings. 
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The following table provides a description of each application preference. 

Application preference Description 

Alert Behavior Determines if alert messages will be displayed. In Virtual PC for Mac, 
many alert messages have a Don’t show again option. If you select this 
option, the alert will not display again in Virtual PC for Mac. However, if 
you want alerts in Virtual PC for Mac to display, click Reset in the Alert 
Behavior preference. 

PC Behavior Determines whether to suspend activity (pause) in background virtual 
machines when you are running multiple virtual machines 
simultaneously. 

Determines if all virtual machines you were running when you last quit 
Virtual PC for Mac will be automatically restarted the next time you start 
Virtual PC for Mac. To set all virtual machines to restart, select Restore 
PCs at launch. 

Full Screen Mode Determines the behavior of the video settings on your Macintosh 
computer when you run a virtual machine in full-screen mode. 

Virtual PC for Mac menus and toolbars are not accessible when the 
virtual machine is running in full-screen mode unless you press the 
COMMAND ( ) key. To return to the normal screen mode, press the 
COMMAND and RETURN keys simultaneously.  

Virtual Switch Determines which Ethernet adapter to use with a virtual machine that is 
set to run with the Virtual Switch network option. 

Sound Sets the behavior of system sounds on all virtual machines. 

CPU Usage Determines how to divide processing resources between Virtual PC for 
Mac and other programs that are running simultaneously when Virtual 
PC 7 is not the active program on the Macintosh computer. 

Script Menu Adds the AppleScript menu to the Apple menu bar when Virtual PC for 
Mac is running. 

Toolbar Selects the items that will appear on the Virtual PC for Mac toolbar. 

Login Sets Virtual PC for Mac to start automatically when you log on to your 
Macintosh computer. 

 
To configure application preferences 

1. In Virtual PC for Mac, on the Virtual PC menu, click Preferences. 

2. Click the application preference that you want to configure. 
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Virtual machine settings 
Virtual machine settings are unique to each virtual machine that you create in Virtual PC for Mac. 
These settings control behavior for each virtual machine rather than for the Virtual PC for Mac 
program. Virtual machine settings control behavior such as printing, connecting to a network, using 
USB devices, and other behavior that applies to individual virtual machines running in Virtual PC for 
Mac. 

Note   For default behavior, you do not need to change these settings. 

The following table provides a description of each virtual machine setting. 

Setting  Description 

PC Name Sets the name for the virtual machine, which appears in Virtual PC List. 

PC Memory Sets how much RAM and VRAM are allocated when this virtual machine is 
running.  

Drive 1, 2, and 3 Assigns additional virtual hard disk images to a virtual machine. Drive 1 is 
the default primary drive.  

Undo Drives Saves all changes made to a virtual machine in a separate Undo file so that 
the virtual hard disk image of the virtual machine remains in its original 
state.  

Shared Folders Creates a shared folder to easily transfer files between your Macintosh 
computer and a virtual machine.  

Mouse Customizes the key combination on your keyboard to enable a single-button 
mouse to “right click.” 

Keyboard Assigns special computer keys, such as the Windows key, to your 
Macintosh keyboard. 

Com Ports 1 and 2 Assigns a physical serial device or file to a virtual machine’s emulated 
serial ports.  

Networking Sets either the Shared Networking or Virtual Switch networking option.  

USB Allows a physical USB device to be used with a virtual machine. 

Dock Determines whether Windows-based programs that are running display in 
the Macintosh Dock. If you have multiple virtual machines, the programs 
running on each virtual machine appear in the Dock. To determine which 
virtual machine is running the program, use your mouse device to point to 
the program you want. The name of the virtual machine will appear above 
the program icon. 

Determines whether to display the Windows Start menu in the Macintosh 
Dock. This version of the Windows Start menu is not a fully functional 
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Setting  Description 

menu, but rather, a quick way of starting a virtual machine and 
Windows-based programs by using the Dock. If you have multiple virtual 
machines, only the programs that are installed on the virtual machine 
(for which this setting is selected) will appear in the Start menu. This 
setting can be selected by only one virtual machine at a time. 

To integrate Virtual PC for Mac with the Dock, you must install Virtual 
Machine Additions. 

Printing Defines which Macintosh printer is used when you print to the Virtual 
Machine Additions Printer in Windows. This is available only if you are 
running Mac OS X version 10.3.x on your Macintosh computer. 

 
To configure virtual machine settings 

1. Do one of the following in Virtual PC for Mac: 

• If you have one virtual machine, on the PC menu, click PC Settings. 

• If you have multiple virtual machines, on the Window menu, click Virtual PC List. Click 
the virtual machine that you want to configure, and then click Settings. 

2. Click the virtual machine setting that you want to configure. 

Copy a virtual machine over the network 
If you have installed a volume licensing version of Windows on a virtual machine, you can copy the 
virtual machine to another Macintosh computer. 

Before you copy a virtual machine to another Macintosh computer 
1. Install Virtual PC for Mac on the source and destination Macintosh computers. 

2. On the destination Macintosh computer, turn Personal File Sharing on. 

To turn Personal File Sharing on, open System Preferences, click Sharing, and select the 
Personal File Sharing check box. 

3. On the source Macintosh computer, create a virtual machine and install a Windows operating 
system and Virtual Machine Additions. 

4. Configure the virtual machine and Windows as needed. 
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5. Use the Start menu in Windows to shut down the virtual machine completely. Click Start, 
and then click Shut Down (or Turn Off). This method does not automatically save the current 
state of Windows. All data that is not saved prior to shutting down is lost. 

In Windows XP Professional, the Start menu displays Shut Down if you are connected to a 
domain and Turn Off if you are not connected to a domain. 

6.  When the status of the virtual machine is “Not Running” in the Virtual PC List, quit Virtual PC. 
Do not copy a virtual machine that is running. 

7. Connect to the destination Macintosh computer and mount the volume where you want to 
copy the virtual machine. 

You can use the Finder Network Browser or the Connect To Server dialog to connect to a 
shared Macintosh computer. See Apple Help for more information about locating and 
connecting to shared computers.  

To copy a virtual machine to another Macintosh computer 
1. On the source Macintosh computer, open the Documents folder, and then open the Virtual PC 

List folder. Make sure that you open the Documents folder in the Home folder of the user who 
installed and runs Virtual PC for Mac. 

For each virtual machine on the Macintosh computer, there is a Virtual PC Document with the 
same name in the Virtual PC List folder.  

2. From the source Macintosh computer, double-click the mounted volume of the destination 
Macintosh computer, open the Documents folder, and then open the Virtual PC List folder: 
Make sure that you open the Documents folder in the Home folder of the user who installed 
and runs Virtual PC for Mac on the destination Macintosh computer. 

3. Drag the Virtual PC Document from the Virtual PC List on the source Macintosh to the Virtual 
PC List folder on the destination Macintosh computer. 

4. Start Virtual PC for Mac on the destination Macintosh computer. The copied virtual machine 
appears in the Virtual PC List if you copied it to the correct folder. 

5. Start up the copied virtual machine from the Virtual PC List and configure it as needed. 

Note   If the virtual machine you copied is set to use Virtual Switch networking, a conflict can 
occur if two computers on a network have the same name and the same static IP address. 
To resolve this conflict, start the copied virtual machine and change the computer name in 
Windows. To change the computer name in Windows, click Start, click Control Panel, and 
then double-click System. On the Computer Name tab, click Change. In Computer name, 
type your computer name. 
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Install additional programs 
Now that your virtual machine is set up with your operating system and connected to your network, 
you can install additional programs on your virtual machine. Use the first procedure to install a 
Windows-based program. If the CD is not captured for use by the virtual machine or the installation 
program does not start automatically, use the second procedure to install the program by using the 
Install Program From Floppy Disk or CD-ROM wizard. 

To install Windows-based programs 
1. Start the virtual machine on which you want to install the program.  

Important   Start your virtual machine before you insert the installation CD for the program 
into the CD drive of your Macintosh computer; otherwise, the CD might be captured for use by 
the Macintosh computer rather than by the virtual machine. 

2. Insert the installation CD for the program into the CD drive of your Macintosh computer. The 
active CD icon on the toolbar in Virtual PC for Mac indicates that the virtual machine has 
captured the CD.  

Note   If the virtual machine does not capture the CD, on the Drives menu, click Capture Disc. 
If your Macintosh computer does not have a floppy disk drive and you must install a program 
from a floppy disk, use a virtual floppy disk image. For more information on creating a virtual 
floppy disk image, see “Create a floppy disk image” in the Virtual PC for Mac Help. 

3. If the Windows-based program has an automated installation tool included, the installation 
program starts. Follow the on-screen instructions. 

To install Windows-based programs by using Add or Remove Programs 
1. In Microsoft Windows, click Start, and then click Control Panel. 

2. Double-click Add or Remove Programs. 

3. Click Add New Programs, and then click CD or Floppy. 

4. Follow the instructions in the Install Program From Floppy Disk or CD-ROM wizard. 

For more information about installing Windows-based programs, in Windows, click Start, and 
then click Help and Support. 
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Add a Windows program icon to the Dock 
After installing a Windows program on your virtual machine, you can add its icon to the Dock. The icon 
for the Windows program will appear in the Dock, even when Virtual PC is not running. To start the 
program and Virtual PC, click the icon. 

To add an icon to the Dock 
1. Start the Windows-based program you want to add to the Dock. 

2. When the program icon appears on the Dock, hold down CONTROL, click the icon, and then 
click Keep in Dock. 

Note  If the Keep in Dock option does not appear, you need to configure the Dock virtual 
machine setting. Click a virtual machine, and then click Settings. Click Dock, and then select 
the Show Windows applications in Dock check box. 

Pause or resume a virtual machine 
Avoid shutting down a virtual machine if you intend to use it again before long. Pausing and resuming 
a virtual machine is much faster than shutting down a virtual machine and then starting it again. Also, 
when a virtual machine is paused, it frees up memory that can be used by other virtual machines that 
are currently running. When paused, the virtual machine’s contents appear dimmed. Each virtual 
machine must be resumed individually. 

To pause or resume a virtual machine 
1. Click the virtual machine window of the virtual machine you want to pause or resume. 

2. In Virtual PC, do one of the following: 

• To pause the operation of a virtual machine, on the PC menu, click Pause. 

• To resume the operation of a virtual machine, on the PC menu, click Resume. 

Note   At times, a virtual machine will pause automatically. This occurs if the virtual machine is 
experiencing a severe memory allocation problem and Virtual PC forcibly pauses the virtual machine. 
If this happens, use the command to resume the virtual machine. 
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Shut down a virtual machine 
When you shut down a virtual machine, you can save its state, shut it down without saving its state, or 
turn it off. Saving the state of a virtual machine puts it in a sleep state. When you next start up the 
virtual machine, its previous state is restored and you can quickly resume your work. Shut down a 
virtual machine without saving its state when you want to make changes to the virtual machine. Turn 
off a virtual machine when it is not responding and the Shut Down option does not work. 

Notes    

• If multiple virtual machine windows are open, click the window of the virtual machine you 
want to shut down. The other virtual machines will be paused in the background and display 
a status of “Running (Paused)” in Virtual PC List. 

• If Undo Drives is selected for the virtual machine you are shutting down, you have three 
options: Discard hard disk changes, Save hard disk changes, or Carry forward undoable 
changes. Learn about these options in the next section, Safely revert by enabling Undo 
drives. 

To shut down and save the state of a virtual machine 
This option saves the current state of the operating system. Any program or file that is open when you 
shut down using this option will be open when you restart the virtual machine. 

1. On the PC menu, click Shut Down. 

2. Click Save PC’s state, and then click Save State. 

Tip   You can also use the Fast Save method, which shuts down a virtual machine and saves its 
state in one step. Click the Close button on a virtual machine window to shut down and save the 
state of the virtual machine. To shut down all running virtual machines in one step and save their 
states, on the Virtual PC menu, click Quit Virtual PC. Virtual PC shuts down all open virtual 
machines, and saves the current state of their Windows-based. 

To shut down a virtual machine without saving its state 
Caution   All data that is not saved prior to shutting down is lost. This option does not save the current 
state of the Windows operating system. 

1. On the PC menu, click Shut Down. 

2. Click Shut down Windows XP, and then click Shut Down. 

Use this option when making changes to your virtual machine, such as turning the Undo 
Drives setting on or off, or when mounting a virtual hard disk image. You must also use this 
option before importing a virtual machine, transferring documents from a virtual machine to 
Virtual PC for Mac, or making a duplicate of a virtual machine. A Windows operating system 
and Virtual Machine Additions must be installed on the virtual machine for this option to be 
available. 
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To shut down a virtual machine if Virtual Machine Additions is not installed 
If you do not have Virtual Machine Additions installed, you can shut down a virtual machine by using 
the Start menu in Windows.  

Caution   All data that is not saved prior to shutting down is lost. This method does not save the 
current state of the Windows operating system. 

• In Windows, click Start, and then click Shut Down or Turn Off.  

In Microsoft Windows XP Professional, the Start menu displays Shut Down if you are 
connected to a domain and Turn Off if you are not connected to a domain.  

To shut down a virtual machine that is not responding 

Caution   Do not use this option unless the virtual machine is not responding and the Shut Down 
option does not work. Turn off PC is equivalent to unplugging a physical computer. If your virtual 
machine is not running Windows, use this option instead of the Shut Down option to shut down your 
virtual machine. 

1. On the PC menu, click Shut Down. 

2. Click Turn off PC. 

To shut down a virtual machine that is not running Windows 

1. On the PC menu, click Shut Down. 

2. Click Turn off PC. 

Safely revert by enabling Undo drives 
As you make changes to the virtual machines on your system, you might want the ability to discard 
those changes. For example, suppose you've installed unnecessary or potentially incompatible 
software. By selecting the Enable Undo Drives setting in Virtual PC for Mac, you give yourself the 
option of discarding such changes. By enabling Undo Drives before you start making changes to a 
virtual machine, you can make incremental additions and improvements on the virtual machine and 
test the results. If you choose to make the changes permanent, you can save the changes to the 
virtual hard disk image when you shut down the virtual machine. If not, you can discard the changes 
by using Undo Drives. 

When you enable Undo Drives, Virtual PC creates a temporary hard drive file called an Undo Drive and 
makes subsequent changes to that file. When you elect to discard changes, Virtual PC discards the 
Undo Drive and the virtual machine reverts to the state it was in when the Undo Drive was created. 
This means that all changes that have been made since the time the Undo Drive was created are 
discarded, including data files, programs you've installed, changes to settings, and Internet or 
document history. 

Caution   Make sure that any files you want to keep are backed up to a different drive before you 
discard changes. 
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Enable Undo Drives 
1. If the virtual machine is running, on the PC menu, click Shut Down , select the Shut down 

Windows XP check box, and then click the Shut Down button. 
Note   The virtual machine must be completely shut down to enable the Undo Drives setting. 
Do not choose the Save State option.  

2. On the Window menu, click Virtual PC List.  

3. Click the virtual machine you want, and then click Settings.  

4. On the left, click Undo Drives Settings.  

5. Select the Enable Undo Drives check box, and then click the option you want. 

 

If you select the Ask to discard drive changes check box, a new set of options appears when 
you shut down your virtual machine or save its state. 

 

Before you shut down or save the state, select one of the following options:  

Discard hard drive changes   The changes saved in the Undo Drive — a temporary hard drive 
file — are discarded and the virtual machine reverts to the state it was in the last time you 
saved changes.  

Save hard drive changes   The changes saved in the Undo Drive become permanent. You 
can no longer revert to a previously saved version of the virtual machine.  

Carry forward undoable changes   The changes are preserved in the Undo Drive but not 
incorporated in the virtual machine. You can still revert to a previously saved version of the 
virtual machine. 



 

Maintaining virtual machines 

33 

 

Maintaining virtual machines 
The information in this section will help you maintain virtual machines on a Macintosh computer. This 
section includes topics on performance, security, Windows updates, backing up data, deleting a virtual 
machine, and removing Virtual PC for Mac. 

About optimizing performance 
You can improve performance by making changes in any of the following areas. 

Processor speed 
The speed of the Macintosh processor is the most important element for overall Virtual PC for Mac 
performance. The processor speed must be a part of the physical computer and cannot be added, 
by using a CPU accelerator, for example. To improve processor speed, you must use a Macintosh 
computer with a faster processor. 

Multiple virtual machines 
When multiple virtual machines are running simultaneously, processing time is divided among the 
different machines. More processing time is given to the active virtual machine. Therefore, the active 
virtual machine is processing at a faster rate than the background virtual machines. To improve the 
performance of the active virtual machine, you can pause all background virtual machines. 

Amount of RAM on your Macintosh computer 
The Macintosh computer uses two types of memory: physical (RAM) memory and virtual memory. 
Physical memory is provided by the RAM chips installed on your Macintosh computer. Virtual memory 
is provided when the Macintosh computer uses the hard disk as a temporary storage location. 

The speed at which the Macintosh computer is able to access memory depends on what type of 
memory it is accessing. Access to physical memory is almost instantaneous. Access to virtual memory 
can vary depending on both the speed of the hard disk and how often the Macintosh operating system 
must swap information to and from the hard disk. If virtual memory requires extensive use of the hard 
disk, access to virtual memory is slow. The more virtual machines you have running simultaneously, 
the greater the memory demands made on the Macintosh computer, which results in slower 
performance. 

Installing more RAM on your Macintosh computer is a cost-effective way to reduce memory problems 
and increase the performance of Virtual PC for Mac. While Virtual PC for Mac requires only 512 MB of 
RAM, for best results, use a Macintosh computer with at least 1 GB of RAM and allocate 256 MB of 
RAM for each virtual machine. The virtual machine uses this RAM only when it is open and running. 
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Processor cache 
The amount of processor cache affects the performance of Virtual PC for Mac. A cache is similar to 
RAM but runs faster because it stores the commands you use frequently in Mac OS X. For example, 
a Macintosh computer with a 1 MB processor cache is faster than a Macintosh computer with a 
256 KB processor cache. 

Processor cache is organized into different speeds for different cache levels. Level-1 (L1) cache is the 
fastest cache memory and is available only on the processor chip itself. Level-2 (L2) cache is often on 
the same chip as the processor. Level-3 (L3) cache is available for some later models of the G4 
processor and is also on the same chip as the processor. To improve processor cache size, use a 
newer model Macintosh computer with the largest amount of L2 and L3 cache available. 

About security 
Virtual PC for Mac uses the security features of both Mac OS X and Microsoft Windows. To learn more 
about the security features of Mac OS X, see Mac OS X Help. 

Important   It is unlikely that a virus will affect the Mac OS or Mac files, but in certain circumstances 
your virtual machine running Windows exposes you to the same security risks that users running 
Windows on a Windows-based computer face. To lower your risk, make sure you always have installed 
the latest Windows security patches and service releases and that you have installed anti-virus 
software.  

Check for Windows updates on the Internet 
To protect the Microsoft Windows operating system that is running on your virtual machine, check for 
updates on the Windows Update Web site. The Windows Update Web site uses a tool that scans your 
virtual machine and gives you a selection of updates that apply to the specific software on your virtual 
machine. New content is added to the Windows Update Web site regularly, so you can always get the 
most recent updates and solutions. You might also want to remind anyone using Windows to check for 
updates on a regular basis. 

To check for Windows updates on the Internet 

1. In Windows, on the Start menu, click Help and Support. 

2. Under Pick a Task, click Keep your computer up-to-date with Windows Update.  

The first time you go to the Windows Update Web site, click Yes when prompted to install any 
required software or controls. 

3. Follow the on-screen instructions. 
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Back up data 
There are two ways to back up data. You can either back up the data on a virtual machine, or you can 
make a duplicate of the entire virtual machine. 

To back up data on a virtual machine 

1. Verify that the virtual machine that contains the data you want to back up is shut down 
completely. In Virtual PC List, the status of the virtual machine must be “Not Running.”  

If the virtual machine is not shut down completely, start the virtual machine. In Virtual PC for 
Mac, on the PC menu, click Shut Down. Click the Shut down option, and then click the Shut 
Down button. 

2. In the Virtual PC List, click the virtual machine that contains the data that you want to back 
up, and then click Settings. 

3. Click the virtual hard disk image (Drive 1, Drive 2, or Drive 3) that contains the data you want 
to back up. 

4. Click Mount Drive Now.  

The virtual hard disk image is mounted as a volume on the Macintosh desktop. 

5. Click the virtual hard disk image on the Macintosh desktop and back up the desired files. For 
more information on backing up files, see Mac OS X Help. 

Notes 

• When the virtual hard disk image is mounted as a volume on the Macintosh desktop, 
third-party software can be used to access the contents of the virtual hard disk image and 
perform an incremental backup. 

• While the virtual hard disk image is mounted, do not move or delete files required by your 
Virtual PC for Mac operating system. Removal or modification of these files can result in 
system failure. To recover from this state, you will need to reinstall Virtual PC for Mac. 

To back up data by duplicating a virtual machine 

1. Make sure that the virtual machine that you are duplicating is completely shut down. In Virtual 
PC for Mac, on the PC menu, click Shut Down. Click the Shut down option, and then click the 
Shut Down button. The status of the virtual machine in Virtual PC List should be “Not 
Running.” 

2. In the Finder, open the Documents/Virtual PC List folder.  

The Virtual PC List folder is the default location for virtual machine configuration documents. 

3. Select the virtual machine that you want to duplicate. 

4. In the Mac OS X Finder, on the File menu, click Duplicate. 

5. Move the duplicate virtual machine to another location; otherwise, it will appear in Virtual PC 
List the next time you start Virtual PC for Mac. 
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Delete a virtual machine 
When you delete a virtual machine, the configuration document for that virtual machine is moved to 
the Trash, and all data is permanently lost when the Trash is emptied. The configuration document 
contains the virtual hard disk image and the virtual machine settings for a virtual machine. It can also 
contain the changes that have been saved in the Undo file for the Undo Drives setting. All information 
stored on the virtual hard disk image is lost when a configuration document containing that 
information is deleted. 

Before deleting a virtual machine, make sure that you have first backed up any data on the virtual 
machine that you want to save. 

To delete a virtual machine 

1. Shut down the virtual machine that you want to delete. To shut down the virtual machine, 
click the virtual machine you want to delete, and then click Shut Down.  

Tip   Alternatively, you can click the Close button on the virtual machine window. 

2. In Virtual PC for Mac, on the Windows menu, click Virtual PC List. 

Verify that the status of the virtual machine in Virtual PC List is either “Saved” or “Not 
Running.” 

3. Click the virtual machine you want to delete. 

4. On the File menu, click Move to Trash. 

5. At the prompt, click Move to Trash. 

6. At the confirmation prompt, click Move to Trash. 

When you delete a virtual machine, only the information contained in the configuration document is 
deleted. Files outside the configuration document are not deleted. 

Remove Virtual PC for Mac 
Use the following procedure to remove Virtual PC for Mac. 

To remove Virtual PC for Mac 

1. In Virtual PC for Mac, on the PC menu, click Virtual PC List. 

2. For each virtual machine that is running, click the virtual machine, click Shut Down, click the 
Shut down option, and then click the Shut Down button. 

3. Insert the Virtual PC for Mac installation CD into the CD drive on your Macintosh computer. 

4. On the installation screen, double-click Manuals & Tools.  

5. If the installation screen does not appear automatically, double-click the Virtual PC for Mac 
version 7 CD icon that appears on the Macintosh desktop. 

6. Double-click Uninstall Virtual PC. 
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Technical support options 
For details on your technical support options, see your licensing agreement. Also visit the Help 
and Support page for Virtual PC for Mac Version 7 on the Microsoft Web Site at 
http://www.microsoft.com/mac/. Here you will find links to highlights, top support issues, help 
and support contact information, and a link to the Newsgroup for Virtual PC for Mac Version 7. Here 
you can also search the Support Knowledge Base (KB) for articles that apply to Virtual PC for Mac 
Version 7. 

http://go.microsoft.com/fwlink/?LinkId=18214&clcid=0x409
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